It is hard to express my excitement about this year’s SLD conference presentations without sounding like every school principal who must annually write something for the PTA newsletter to the effect that, “This is going to be the best year ever!” But I sincerely feel that, at least on paper, this looks like the best assortment of presentations the SLD has been able to offer its membership in several years. We will be given an opportunity to delve deep into questions of nuance, style, equivalence, semantics, culture, humor, terminology, and even the role of punctuation in all of these. I, for one, feel that I am going to leave Seattle with new and valuable information between my ears. And what’s more, if I can get out of bed early enough, there will be “Yoga Stretches for the Translator” every morning from 6:00-6:45 am, where we can learn “simple techniques for making your day more energized, organized, and productive from the very start.” I think anyone who occasionally has to spend a dozen-plus hours a day frantically trying to make a deadline could use some of that! That’s for the body, but we have lots for the soul as well—each other, first and foremost. See the back page for details about our annual banquet. Conference newcomers are particularly encouraged to join us for this event, which will include the back-by-demand SLD sing-along.

Also for the soul, I’d like to put in a plug for the Literary Division’s After Hours Café, at which ATA members read from their translations of poetry or prose, or, in some cases, their original work. You can come just to listen and enjoy complimentary coffee and tea (or the cash bar), or you can bring something of your own to read. No prior commitment is necessary—just show up with text in hand and put your name on the list of readers if the spirit moves you.

2005 SLD Conference Sessions

You can find presentation abstracts and presenter bios on the ATA web site. Rather than repeat information that is already available, I offer below a bit of отсебятин.

**SL-1** Terminology in Legal and Social Services Brochures

*Emma A. Garkavi and Vadim Khazin*

This session, the primary language of which will be Russian, stems from the speakers’ experience in translating into Russian concepts that are only now emerging in that language. Translating terminology used in American small claims court, by collection agencies, and concerning tenants’ rights, living wills, and affidavits of support requires a deep understanding of both U.S. and Russian/Soviet legal concepts and culture. Social services translation (and interpretation) is a growing field, as federal, state, and local government increasingly strives to provide culturally and linguistically appropriate services.

**SL-2** Boon or Bane? What You Should Know about the English>Russian and Russian>English Certification Exams

*Boris M. Silversteyn and James E. Walker*

Both presenters are certification exam graders. This session will be of interest to anyone thinking of taking an exam, even in Slavic languages other than Russian. In addition to providing background information on passage selection and grading procedures, typical examples of translation errors from past exams will be discussed. I believe this aspect of the session should be useful to anyone who knows Russian, whether or not they have already passed the exam.

*Continued on page 19*
ATTENTION: NEW SLD MEMBERS, FIRST-TIME CONFERENCE ATTENDEES

Leah Misbin

New to the Slavic Division? Feeling a bit nervous about plans to attend the upcoming ATA Conference in Seattle?

ATA has an excellent mentoring program, providing a way for those new to the profession to learn firsthand about the field of translation and how to break into it. See the ATA website (www.atanet.org) for more information. This year, SLD will also attempt to provide a “conference mentoring” program in Seattle to pair old hands dying to share expertise with relative neophytes (to the profession, division, or conference). If you are interested in becoming a conference mentor or mentee, please write Leah Misbin at gruzinka24@yahoo.com. She will also attempt to match up roommates.

The first planned event of the conference is the general Wednesday evening reception. Even with the incentive of free and delicious hors d’oeuvres and drinks, it may be daunting to enter a crowd scene when you don’t know anyone. To avoid this, Leah Misbin, SLD Newcomer Conference coordinator, and other long-time members will meet with newcomers 15 minutes before the reception starts at its entrance. We will have a CONSPICUOUS sign.

Next, come to a special Slavic Division “meet and greet” lunch, which will take place on Thursday, 10 November at 12:30. Plan to meet other Slavic linguists at the Conference registration desk whence we will proceed together to an informal lunch location. Newcomers to the division/conference, SLD functionaries, mentors and mentees, and other interested members are encouraged to take part.

Do not miss the SLD meeting, currently scheduled for Friday. At its start, newcomers and others will be asked to introduce themselves and say a little about their interests and specialties, so that people needing or able to provide help or advice can identify each other. Also, those wanting to get more than their toes wet at this conference will have ample and varied opportunities to volunteer at the meeting.

We are trying to get a head start on our planning while ATA schedules are still in a state of flux. As plans develop and/or change, we will try to send out announcements to Slavic Division members registered for the conference. Please take advantage of these great opportunities to get to know other members! Write Leah if you have any questions or suggestions.

Leah Misbin, a conference newcomer last year, worked and studied in Russia for approximately five years. She currently works as the education and events coordinator at The International Society for Prevention of Child Abuse and Neglect in Chicago, Illinois. Email: gruzinka24@yahoo.com
AN INTERVIEW WITH SVETOLIK PAUL DJORDJEVIC
SLD 2005 Susana Greiss Lecturer
Nora S. Favorov

For more information about our 2005 Greiss lecturer and his talk, please see the Conference Preview starting on page 1.

NSF: There are rumors that you work with a remarkable number of languages at the Social Security Administration. How many languages do you know, and how did you learn them?

SPD: During my lecture, I will talk a little about my personal background: where I grew up, where I went to school, the languages I studied, the countries I lived in, and the jobs I held prior to becoming a translator in 1965. The ones I studied formally include Old Church Slavonic, Russian, Greek, Latin, German, French, and English. As for the rest of the languages I do at SSA, I learned them through work. I can tell you here what they are, and how I learned them. First, I need to provide a disclaimer. I am rather reticent to talk about knowing X number of languages. My understanding of linguistics prevents me from believing that there can be an equal knowledge in all aspects of even two languages, let alone more than that. So, when I say I work in 36 languages, what that means is that I have learned the structure of that many languages, and am able to translate from those languages rather simple letters and legal documents (birth, marriage, death, land transaction, child support, divorce, etc.). The languages are: Albanian, Armenian, Croatian, Czech, Hungarian, Rumanian, Bulgarian, Slovak, Slovenian, Polish, Ukrainian, Estonian, Latvian, Lithuanian, Finnish, Norwegian, Swedish, Danish, Dutch, Italian, Spanish, Portuguese, Turkish, Maltese, Thai, Cambodian, Indonesian, and Vietnamese. Plus the languages I already mentioned above. The split between Serbian and Croatian and Czech and Slovak automatically increased the number of languages I do.

How did it happen? Take Vietnamese, for example. SSA needed a Vietnamese translator, once documents in that language started piling up in late ‘70s and early ‘80s. I volunteered for the job, providing they gave me an hour or so a day to study the language. I found a Vietnamese-Russian Dictionary which also had an extensive section on Vietnamese grammar in the front. So I went to work, studied the grammar, and learned the intricacies of the language. So with the help of the dictionary I was/am able to translate simple documents. And it went like that from language to language.

NSF: I understand that you have been working at the Social Security Administration for over twenty years. What exactly do you do there and what have been the particular challenges of that job?

SPD: I went to work for SSA in June 1981. Although much of my translation work deals with the material mentioned above, over 90% of my time is spent on medicine. I translate medical evidence from 11 languages, i.e. the Slavic languages, plus French. Challenges? Lack of adequate reference works. This was especially true during the pre-computer age. Paper dictionaries were (and, as far as I am concerned, continue to be) either non-existent, or inadequate for the work I was doing.

NSF: And that brings us to the next question I was going to ask you. What motivated you to become a lexicographer?

SPD: What motivated me to spend 25 work years on compiling dictionaries? Come to the lecture, and you will hear about it. You will hear about the motives and about the process. I can tell you this much, though. I have NOT read any “how to” books. The motives were clear and firm, while the process was not. There were many additions and changes on the way, for the simple reason that I never contemplated “writing” a dictionary. It took off, and I never stopped. I progressed from a notebook in which I was collecting mainly medical abbreviations in different Slavic languages and French to the electronic and published forms my dictionaries are in today.

NSF: We look forward to hearing all about it.

Russki on the Roadways, Polski in Parking Lots, Hrvatski on the Highway:
Slavic-Themed License Plates

As you drive around town, do you see license plates that not everyone will understand, but you do? Of course, in Brighton Beach most of the locals will “get” the meaning of the license plate RAZOR, frequently seen on Oceana Drive, while few in North Carolina can make sense of CTEPBA or BI3OK (Ukrainian diminutive for horse-drawn wagon), sighted in those parts. Most likely, many states have had orders for license plates spelling the baffling (for non-Slavophones) YKPAIHA. SlavFile editor Lydia Stone has been confusing the uninitiated with her PEREVDOD for years. Is she the only SLD member to do so? It may involve stretching the mission of this newsletter just a tad, but we are starting a collection of Slavic license plates sighted around the country. Do you have a Slavic-themed license plate on your car? Do you see them on the highway? Let us know (norafavorov@bellsouth.net). We will print the list in a future SlavFile.
Sweet are the uses of adversity.
William Shakespeare
As You Like It, II, i 12

There were several topics that were not encouraged as subjects for discussion in the house where I grew up, namely: politics, religion, sex, ill-health, and money. (Yes, I know: what else is there?) And, although I left home several decades ago and should have grown out of it by now, I still find myself cringing a little when I have to talk about money. So it’s probably more due to good luck than to good management that in my freelance career I have not yet had to get seriously nasty with a client over being paid in a fair and timely manner—which is not to say that I haven’t had to contact clients with a payment reminder or that I haven’t had to stick to my guns when told by a potential client that I charge too much. I just don’t find those exercises to be a whole lot of fun.

Still, forewarned is forearmed. When the day comes that you aren’t getting paid promptly and you want to do something about it, it’s surely easier if you already have a notion of where to start. That’s the basic purpose of this column.

But first, if you haven’t yet read Ted Wozniak’s “Ensuring Payment” in the April 2005 ATA Chronicle, you really should, since it is an encyclopedic compendium of information and counsel on this very subject. I think have a couple of things to add, but if you find that I am hitting some of the same points that Ted did, I hope you’ll agree that sound advice can never be overstated.

For instance, everyone will tell you—and everyone is right—that you must distinguish untimely payment from an outright refusal to pay. Andrei Gerasimov, in an article entitled “Collection” that you will find in Accurapid’s wonderful online Translation Journal (http://accurapid.com/journal/26collection.htm), makes an excellent point: “Do not mistake poor communication and organization and banking mistakes for an attempt at non-payment...If you cannot differentiate between non-malicious late payers and malicious non-payers, you could lose a valuable client by being too harsh during the collection process.” (On the other hand, repeated and lengthy delays in payment and misinformation about when a payment may be expected, while perhaps not malicious, are not only distressing but can cause financial hardship to vendors, and one would certainly wish that all companies were aware of that self-evident fact.)

You probably already have a feel for the sloppy payers, large and small, among your clientele: they’re inefficient and unprofessional, but they’re not conspiring to avoid paying you altogether. You may also recognize when a smaller client is having a genuine cash-flow problem and be willing to ride it out with them (more on that later). It’s up to you—this is your business, after all—to weigh the circumstances of each case and decide whether or not to take a hard line and at what point to replace your reminders about payment with demands for payment. The better you know your clients from the various sources of information out there and from your own experience, the more appropriate your decision is likely to be. It seems clear to me that a polite and friendly (but not supine) approach would produce better results than confrontation, at least in the early stages.

Remind yourself of the client’s payment terms—in the contract, in the e-mail that stood in for a contract, on the Purchase Order, in the notes that you made during your conversations with the client before you began the job. If you’re a stickler for these things (I must confess that I’m not), you’ll want to keep a list of those dates, so that you will know for sure when a given invoice is past due. Be meticulous about it if you’re going to do it at all: it’s pretty embarrassing to find out that you’re agitating for money that isn’t yet due to you, and it doesn’t do much for your client relations. But if you have accepted and completed a job without the faintest idea of the client’s payment terms or have tacitly agreed to something like “when the client pays us,” of course you’ll be on shakier ground in your quest for payment.

If the client is citing a quality issue, which Ted Wozniak believes is “the most common reason for clients not paying” (and can also cause late payments, as they scramble to find out “what went wrong”), you need to take a deep breath, calm down, find out precisely what the issues are, and evaluate them honestly. Does the contract specify the client’s general quality requirements and, more importantly, dispute resolution arrangements? With that in hand, you have a road-map for action, if you intend to dispute the client’s quality complaints. But if you find that you really have produced something indefensibly inferior to your normally impeccable standards, apologize, and offer to do whatever you can to fix or alleviate the problem. (There is also a terrific short piece on “The Art of Apology” by Barton Goldsmith in the April Chronicle.) But remember that even if you have given inadequate service, you may be justified in requesting payment for some portion of the originally agreed amount—even if your work was so bad that you wouldn’t blame the client for throwing the whole thing out and starting over. Stuff happens, and we all have off days.

Let’s assume, though, that the payment date has come and gone, there are no quality issues (or they have been resolved to mutual satisfaction), and you still haven’t been paid. Let’s assume also that you are in some kind of communication with your client—because if they aren’t picking up the phone or are leaving you on hold indefinitely, are not responding to your e-mails, or are making payment promises that they do not keep, you would certainly be forgiven for suspecting that you are dealing with an intentional non-payer. And that’s a whole other problem, which we will talk about later.

When you are ready to start chasing your money in earnest, let escalation be your watchword.
This would be as good a place as any to remind you, as if you needed reminding, that I am not an attorney and that nothing in this column constitutes legal advice, from me, the SlavFile, or the ATA. It is not an encouragement to move as a group against any client or to do anything else that would constitute a violation of U.S. antitrust legislation (about which there is a fine article called “What Could Be the Harm in That?” in the April Chronicle).

Now that that’s out of the way, there are two basic rules that you need to remember: 1) You are in business, and when you agree to do any work that is not paid in advance, you are extending credit. That is exactly as serious and responsible a business relationship as it sounds; and 2) Your contract, whether actual or implied, is with your client, and if your client is a translation company or agency, they are the ones responsible for paying you. Whatever financial agreements they may have made with their own clients are not your concern, and should not enter into discussions about payments owed to you. Many of your colleagues will also tell you that you should never, ever, sympathize with a client’s sad tale of temporary cash-flow problems and let them slide on those grounds. I would say that’s entirely up to you. But even if you are mercifully inclined, you do need to have a good sense for when a cash-squeeze is about to mutate into a permanent inability to pay. It’s a fine line, and I would imagine that’s entirely up to you. But even if you are mercifully inclined, you do need to have a good sense for when a cash-squeeze is about to mutate into a permanent inability to pay. It’s a fine line, and I would imagine that’s entirely up to you.

Escalation. now. Andrei Gerasimov offers a suggested escalation schedule in his “Collection” article. Of course, what works for him might not fall within your comfort zone; again, that is a decision for you to make.

Here are some other ideas that I have picked up over the years, some of which were volunteered by respected colleagues. I offer them for whatever you think they are worth.

1. Try a pre-emptive nudge. If you have a client that you otherwise like but is routinely lax about payment deadlines (especially one that seems to wait for you to inquire about payment status before even thinking about paying you), a pre-reminder might be just the thing. Laura Hastings, owner and moderator of the Translator Client Review list, sends an e-mail a little before the due date, citing invoice and/or PO number, the amount of the invoice, and the agreed date of payment asking for “an update on when the payment for this work will go out.” Among the many virtues of this idea is that it reminds the client that you run your business professionally and that your financial house is in order.

2. Put a notation on your invoice. I have exchanged e-mails with a counselor with the Service Corps of Retired Executives (SCORE), who recommends an invoice notation stating when payment is expected (provided this does not contradict any contractual agreement with that client) and the late fees the client can expect to pay if payment is not received by that date. That may indeed have an effect on a merely dilatory client, though it can be overlooked (who has time to read the small print these days?), so you should point out when sending the invoice that your payment terms have been tightened.

But I would strongly suggest checking with a local business attorney or CPA first, to ensure that the rates you want to apply are not usurious. And you also need to consider how hard-nosed you may have to be to collect those late fees. Reports on client payment practices boards indicate that some clients pay the fee without demur, but you surely can’t count on that. Again, you need to weigh the face you will lose if you don’t insist on the late fees being paid against the client you could lose if you do insist. Then again, maybe this is a client that you wouldn’t really mind losing at this stage.

Incidentally, for free advice from friendly and helpful individuals on business matters, I don’t think you can beat SCORE (www.score.org). Just don’t expect any counselor you select to be well-informed on the translation and interpretation business. Mine went mildly ballistic when I told him how long some clients take to pay, and told me to dump any such clients forthwith. I didn’t argue.

3. Back yourself up with local legislation. Some countries, believe it or not, actually have laws about payment cycles: the European Union, for instance, has instituted a Late Payment Directive (Directive 2000/35/EC, to which you can link from http://europa.eu.int/comm/enterprise/regulation/late_payments/index.htm, in case you haven’t been able to get to Ted’s article in the April Chronicle). Find out all you can about the local regulations regarding payment (an appeal for advice on a payment practices discussion forum will often give you all the information you need), and cite the relevant legislation in your subsequent communications with the late-paying company. That would certainly impress me. An added advantage is that by doing this, you will also learn local regulations regarding fair debt collection, which it would be a bad idea to violate.

Ted mentions finding dunning letters for the country in question on the Internet, since various conditions must be observed in various areas for a collection letter to be legally effective. I found some for the US at www.creditguru.com/collection.htm (no special recommendation here—it just topped the list of hits during my Google search).

4. Throw in some legal muscle. Another colleague makes it clear, with a “cc” notation, that she is sending a copy of her final demand for payment to her attorney. That is something I would never have thought of, perhaps because I don’t have an attorney, but some clients must surely find that somewhat daunting.

5. Let your client know you’re not alone. Some translators inform clients of their plans to communicate their experience to the wider community. What they mean, of course, is that they are about to post a report in a payment practices venue, but if you do this, please don’t blurt out anything like “I’ll be telling everyone on www.xyz.com what a rat you are”—first, because that’s not polite, and second, because it is hardly fair to the moderators of those sites, who definitely do not need irate clients going after them.

Continued on page 18
A short time after I joined the ATA and the Slavic Division earlier this year, Mary David of ATA headquarters kindly sent me some issues of the SlavFile to get me acquainted with the Division and topics of interest discussed there. Then a warm email from Lydia Razran Stone, the editor of the SlavFile, arrived in my inbox welcoming me and encouraging me to write a few words about myself or about translating in Australia, where I used to live before moving to the US this past year. I was quite overwhelmed and not certain whether to stick out my neck.

I pored over the SlavFiles with great excitement, enjoying the wit, observations, and breadth of knowledge displayed by many regular contributors. I checked out the recommended websites, internalized tons of advice and warnings, and pondered my chances of breaking into the new, American market with increasing trepidation. How much easier it was to be part of the familiar structure in Poland and then in Australia!

I thought back to the 1970s, when I was still in Poland, working on my Ph.D. in linguistics and teaching undergraduate courses in the English Institute at the University of Poznan, proofreading two linguistic journals, translating articles for other university publications, translating art pamphlets and other texts into English, interpreting at conferences. Life was very busy indeed. Then my new American husband was offered an academic position at the University of Newcastle in New South Wales, Australia, and we relocated Down Under for what was to be a few years but stretched into twenty-five (talk about Australia growing on you!). There was no choice but to begin anew, far away from the comfort of my beloved adopted city of Poznan.

As sometimes happens, the new country made it necessary to revise my work plans and ambitions. I was thrilled to do some tutoring and then part-time lecturing in second language acquisition and applied linguistics in the Linguistics Department at the University of Newcastle. However, initially, I did not see any opportunities for translating or interpreting, let alone using Polish.

Soon enough, I found out that there was a sizeable Polish community in Newcastle, and while traveling around the country I found that my compatriots were everywhere. Following World War II, Australia welcomed hundreds of thousands of displaced persons from many war-ravaged European countries, including Poles. It offered them a safe haven and work. In the post-war assimilation-policy days, languages other than English were discouraged, I was told. It was assumed that, with time, settlers would acquire English and adopt the values of their new country. In the meantime, however, in times of need, many had to rely on their relatives, friends, and children who knew some English. For a number of years, it was such individuals who acted as “interpreters” in hospitals, doctors’ offices, police stations, and courts of law. This was inadequate and at times embarrassing, but the recipients were always grateful.

The first interpreters I came in contact with, in 1979 in the industrial port of Newcastle, a city of 262,000 inhabitants, were community interpreters, a rather new concept for me. Most did not have tertiary education or proper training. Their command of English and their native languages varied, depending on their age and educational background. Young and cocksure, I did not want to identify with them. I knew it took more than being bilingual to be a translator/interpreter in Europe, and it was hard for me to accept any less.

As it turned out, there was a great deal for me to learn. Newcastle had heavy industry that I was not familiar with, and accidents at work occurred with alarming frequency. Immigrants suffered a wide range of ailments that, as a healthy individual, I had never heard of. There were compensation cases, criminal cases, divorces, and coroner’s inquests—in Poland I had never been to court! People needed to have their wills sight-translated, entered into contracts, applied for housing loans, needed to have treatment and surgical procedures explained. It was a world of new experience to absorb, and time to learn some humility.

Starting in the mid-1960s, the “White Australia” policy of the post-war years began to weaken, to be totally scrapped by 1973. Australia began accepting larger numbers of immigrants with various non-European backgrounds. In a society that was already a rich mixture of cultures, the assimilation policy of earlier years had to give way to the philosophy of multiculturalism, which better reflected the cultural and linguistic diversity of Australian society. In 1978, the year we settled in Australia, the multicultural policies were officially implemented with far-reaching consequences: ethnic media, ethnic language programs in high schools, and the provision of interpreters in all government-funded institutions (hospitals, courts, schools, employment agencies, etc).

The era of untrained bilingual speakers acting as interpreters was slowly coming to an end. There was an increased awareness of standards to which translators and interpreters should adhere. Government language service providers launched extensive training programs for their panels of translators and interpreters. They also encouraged them to have their language skills tested by the newly formed body, the National Accreditation Authority for Translators and Interpreters (NAATI), whose purpose was to set, monitor, and assess professional standards. In 1980, I applied to NAATI and was granted a professional rating (level 3) as a translator and interpreter.

For the first couple of years I was in Australia, I focused on university work and translations. Most Polish interpreting was done by a few individuals who had arrived before I did and had their spheres of influence well-mapped. It was hard to imagine that Polish would ever be popular enough to keep both them and me busy. Then, the unthinkable happened. The political situation in Poland began deteriorating, and large numbers of young Poles filled refugee camps in Austria, Italy, Germany, and other Western European countries. In the early eighties, Australia opened its doors to thousands of them, and suddenly there was a flood of Polish documents to translate, as well as many...
publications, announcements, pamphlets, and brochures, produced by government bodies for the benefit of new and previous immigrants.

Among the bigger assignments I remember were a diabetes information booklet and a NSW Drivers Education Manual that has since been replaced by an updated version that was not translated. There was also a long series of “first of a kind” interpreting assignments that multiplied with time: the first rape case and counseling, the first “head-on collision” with the traditional last Will and Testament (legal plain English documents were not used yet), the first negligent death and a coroner’s inquiry, domestic violence, sexual assault, mental health hearing, aggravated assault, divorce proceedings, etc. And there was the wonderful experience of telephone interpreting that covered the widest range of situations. Telephone Interpreting Service calls used to hijack many free moments of my days, making them unpredictable, sometimes tense, and always interesting.

In later years, the bulk of my interpreting involved legal matters, and I worked not only in Newcastle, but also assignments in various courts in the Sydney metropolitan area and rural New South Wales. I would also receive calls to interpret in public hospitals and clinics, many of them being emergencies at odd hours of the day and night. When we started a family, I decided to concentrate exclusively on freelance translating and occasional interpreting, as it offered more flexibility than teaching. I could work to my own schedule and say “No” when the going got tough.

In the meantime, the situation in Poland continued to evolve, and by the late 1980s and early ‘90s Poland began attracting foreign investors, including some Australian companies. In the ensuing years, I translated substantial amounts of material relating to business, accounting, operational instructions, executive presentations, legal matters, and other areas.

Apart from qualifications documents, many of my previous translations had been from English to Polish. In early 2000, I translated a few feature articles from Polish magazines into English for the benefit of the English-speaking descendants of the community—I edited and also translated into English material relating to business, accounting, operational instructions, executive presentations, legal matters, and other areas.

The interpreting and translating scene I was leaving behind when I moved to the US in 2004 had undergone many transformations since the 1970s. For several years now, colleges and universities throughout Australia have been offering diploma and degree courses in translating and interpreting. Many practitioners are highly qualified, and most have sound training these days. A minimum requirement for interpreters and translators seeking employment with Government agencies has been raised from the “Para-professional” to the professional “Interpreter” and “Translator” level. The image of a community interpreter and translator has also changed, thanks to more stringent quality controls, and the efforts of AUSIT, Australia’s national association for the translating and interpreting profession, which has been raising public awareness about the profession since 1987. Together with NAATI, it has been monitoring and supporting excellence in the field.

In February 2004, the Department of Immigration and Multicultural and Indigenous Affairs (DIMIA) established a new telephone facility enabling English-speaking professionals to automatically access interpreters in 18 high-demand languages. ATIS (the Automated Telephone Interpreting System) has proven quite popular, saving customers time and money. Interpreters speaking other languages are also accessible, but through the sometimes less efficient TIS system.

The number of qualified translators/interpreters nationally runs into the thousands. However, not all are equally busy. The demand for languages changes constantly, and ties in with Australia’s humanitarian programs and new immigrant intake. According to DIMIA, the top 10 languages enjoying the highest demand for translation at present are Arabic, Serbian, Chinese, Croatian, Bosnian, Russian, Spanish, Persian, German, and Indonesian.

Continued on page 9
SLAVFILE LITE: NOT BY WORD COUNT ALONE

Lydia Razran Stone

Recently I unearthed an article I wrote years ago for a nature publication entitled “Twelve Life Lessons I Have Learned from Birdwatching.” (Example: The Cardinal Rule: No matter how wonderful a thing is intrinsically, if it is very common it will not be much valued.) With a column to fill, I got the idea that a similar list could be written about translating. So, here one is:

THIRTEEN LIFE LESSONS I HAVE LEARNED FROM TRANSLATING

1. Ask questions!
2. Pay attention!
3. Keep looking!
4. Context is everything.
5. Sometimes you can make a silk purse out of a sow’s ear.
6. There are too many sows’ ears around to do it every time.
7. There is no such thing as a useless piece of information.
8. There is always another error to be found.
9. What people say is not nearly as important as what they mean.
10. It helps if you understand what you are talking about.
11. No matter how much you know about a topic, there is always something critical that you do not know.
12. Someone else does know it.
13. If you are not having fun, find something else to do.

Speaking of lists, I have been involuntarily acquiring a “hate list” of recent new usages in English. I think I will present them here, but only a few at a time to avoid poisoning SlavFile’s genial atmosphere.

1. Hydration: probably I dislike this word because I am disproportionately irritated by the yuppie fixation on designer water. Recently I saw an advertisement for such a product that included the phrase “for your hydration needs” and realized that this was just a fancy way of saying “to drink,” one attempting to justify asking a ludicrous sum of money for something that is generally available gratis.

2. Famously: lately this (to my mind egregious) word is be- ing used in the media to describe an action that has become well-known, as in, “As Confucius famously said…”

I feel that the birth of this usage is somehow associated with the relatively recent phenomenon of “being famous for being famous.” I want to justify the fact that this usage so grates on my nerves by asserting that adverbs must be used to describe the manner in which actions are performed, including their instantaneous effect on other people, (e.g., impressively, rightfully) and not their subsequent consequences, but somehow I sense that this explanation is too simple. Any comments?

3. Issues: I dislike the current usage of this word not only because it is a euphemism (on the order of challenging) but also because it lumps all possible lumps in the oatmeal into a single category. Thus, X has issues with Y can mean that X dislikes, hates, resents, objects to, has a scheduling conflict with, is allerg- tic to, is phobic about, requires further clarification in regard to, considers Y impossible, etc., etc. I once heard someone on a gardening show say that a particular tree’s roots had issues with every spot in her yard. The New Yorker ran a cartoon, showing a man talking to a small boy, captioned, “Daddy doesn’t hate the New York Yankees, Daddy has issues with the New York Yank- ees.”

To be continued…either with the rest of my list or, I hope, with reader contributions of usages (in English or Russian) they love to hate.

Joseph Bayerl writes: “In response to your musings [see Summer 05 SlavFile] over what to call Cyrillic that has gone bad in electronic transit, how about, ‘sans Cyrillic’ as a term that takes some literal French and then plays a little with Saint Cyril and well known ‘sans serif.’” And on another topic: “Enjoyed the revisited article on translation technology from the archives! In a spare moment this evening, I plugged ‘Human Translation’ and ‘Machine Translation’ into an anagram engine, www.wordsmith.org/anagram, and came up with the significant rearrangements: Machine Translation=International Chasm and Human Translation=Rational Huntsman.”

Incidentally, the article from the archives, the John Henry parody on machine translation in our summer issue, was written by Kim Braithwaite, which may not have been made sufficiently clear in the introduction to the piece.

SERIOUS BUSINESS: WE NEED NEW EDITORS

The terms of our SLOTR (Slavic Languages Other than Russian) editors have expired and we are seeking volunteers to take over these posts. An editor’s duties would include writing a column or one or more articles and/or soliciting articles from others and/or identifying published or Internet articles suitable for publication by us. We would not think of requiring that every SLOTR editor produce something for us for every issue, but it would be nice if each of the “other” Slavic languages were represented in our pages at least once or twice a year. We are looking for editors to cover Polish, Czech, and Slovak, one or more subsets of South Slavic, and Ukrainian and Belarusan. We would also love to have someone fulfilling this editorial function for interpreting (as opposed to translating), which we feel is underrepresented in our publication. Really and truly, this is not an onerous job, and will certainly bring your name and skills to the attention of others in the profession, as well as earning ATA continuing-education credits. Newcomers to SLD, though not to their languages, are enthusiastically encouraged to apply. Contact Lydia at coordinates on the masthead.

See you in Seattle!
MORE FROM MY UNPUBLISHED LITERARY TRANSLATION ARCHIVE

HIPPO-PO-POEM
Vyacheslav Kupriyanov
Translated by Lydia Stone

One thing that we learned in our time full of shame,
We all know to cringe when we hear evil’s name.
Oh please do not blame us
For justly infamous
Tsar Hippo-po-tamus!

He lived off our labor for many long years,
He lived off our hippo-po-blood, sweat and tears
While he hippo-po-wined and hippo-po-dined
And relaxed on a hippo-po cushion reclined.
He grew stinking rich through hippo-thetical deals
Spouting hippo-po-hype in his hippo-po-spiels.
Thus he soared to the top of the hippo-po-heap,
While we, his poor subjects, did nothing but weep.
We were treated like zeros—to him our true worth,
While he thought himself hippo-hub of the earth.
On his hippo-life story they wrote boring tomes
His hippo-po-portraits disfigured our homes.
And hippo-po-paeans assaulted our ears.
As his hippo-po-flunkies led hippo-po cheers
“Hip-hippo-hoorah, hip-hippo-hooray
Give thanks for our hippo-po-era today!”
True hippo-po-crits were assured of success
While back-sliders were punished and made to confess
And those who resisted such hippo-po-nosis.
He sent to locked wards for their hippo-psychosis.
So you see we had reached hippo-bolic extremes
Which luckily, don’t last forever, it seems.
Kind fate put an end to our hip-tatorship
We heard that the hippo was dead of the grippe.
He was dead of the grippe, or the hippo-po-flu,
Whatever, we’d never see his like anew!
Of the hippo-po-plague we were finally rid!
And no other we’d ever let do what he did!
Yet rumors now claim he is not dead, in truth,
But lives under the alias Tsar Be-he-muth.

POLISH TRANSLATION IN AUSTRALIA
Continued from page 7

Not all the translating and interpreting services are fee-free any more. Over the years, the number of documents translated free of charge has been reduced to a few relating to settlement (birth certificates, marriage certificates, qualification/employment documents and drivers’ licenses). Likewise, the number of “on-site” interpreting assignments has decreased in favor of telephone interpreting, mainly due to the high cost of on-site jobs. The “Doctor’s Priority Line” makes it easy for a medical practitioner anywhere in Australia to access an interpreter from the national pool of 2000, which is of particular importance in rural areas. Courts, however, must rely on “on-site” interpreters who need to be booked in advance.

Many say that the work of a translator is lonely. Wrestling with words in the privacy of one’s own home can become somewhat isolating. However, intertwining translations with interpreting as well as teaching and training offered me plenty of variety to keep loneliness, boredom, and frustration at bay. I feel privileged to have been able to use my bilingual skills and linguistic knowledge for the past 25 years. I feel privileged as well to have been part of the ever changing translating and interpreting profession in Australia. Hopefully, my experience in the US, although no doubt quite different, will be as rich and satisfying.

Aleksandra Horn now lives with her family in Baltimore, Maryland, and continues to do both translating and interpreting between Polish and English. She can be reached at olahorn@yahoo.com.
Old Business

I was extremely gratified to receive two responses to the previous “Nuts and Bolts” column, both of which contained some additional hints that I would like to pass on to you. First, Michael Ishenko provided a site to help out with converting a Russian transliteration of a Chinese name to an English transliteration: http://chinese-russian.com/phoneme/. Not only does the site provide English and Russian transliterations of all of the Chinese phonemes, but it also provides audio files for the phonemes in every tone (as many as five) for the linguistically curious among us.

Next, our esteemed candidate for SLD Administrator, Joe Bayerl, sent in some very useful Google tricks of his own. First is the “define” operator, which limits searches to glossaries and dictionaries. Try Googling “define: translator” or “define: hematopoiesis,” for instance. The results page includes links to the sources. An added bonus is that “define” will also find definitions for Russian terms, with the definitions usually in Russian, but sometimes in English (try “define:бактерия” and “define:пирог”). However, Russian is not covered nearly as extensively as English. The “define:” feature can be used, obviously, to find out what a word means, but also to confirm a proposed translation of a particular word by comparing definitions for source and target and to hunt for useful on-line glossaries, both monolingual and bilingual.

Next, Joe suggests doing similar source/target comparisons using the Google image search (http://images.google.com, also accessible from the main Google site). If the images that come up for both source term and target term are similar, this bolsters the case for using that particular target term.

Finally, Joe mentioned that he often uses bilingual Google queries (searching for both source and target terms simultaneously), which were touched on in the previous “Nuts and Bolts.” He notes that in particular, if one of the terms he is investigating frequently occurs immediately after the other in parentheses, it raises his confidence in his translation of the term.

Thanks, Michael and Joe!

New Business

Formatting documents is a big part of a translator’s work, but one for which we rarely get paid extra. Looks do count, however, and if your stellar translation looks disorganized and sloppy, the merits of your work may be overlooked. So in this issue, I’ll provide a few formatting tips and tricks, and hope that you will send me yours as well. Again, my own biases will be evident; for instance, I work primarily in Microsoft Word. Take what you like and leave the rest.

I confess that I am fussy about formatting. Part of that is my detail-oriented personality; part of it is my training. I was thoroughly indoctrinated in my first job out of college, in which I served in a word processing pool for a large defense contractor. This was in the days before personal computers, and we all worked off of an enormous mainframe that held disks the size of flying saucers and used a very cumbersome word processing program. Our regimented formatting requirements derived partly from government standards and partly from the need to streamline our work in the face of that inelegant word processing software.

So with that introduction (or perhaps warning), here are some formatting recommendations that I hope you find useful.

• Find out what your client’s formatting requirements are. Does the client want to retain the original pagination and/or the original formatting? Or does your client just want a final product that looks good? Are there any specific format requirements, such as font, font size, or margins?
• Never, never, never use spaces instead of tabs. NEVER!! (Okay, I admit, it’s a pet peeve.) If you do, and you or your client needs to change the spacing, it will be far more laborious to change all of those spaces. Furthermore, in these high-tech days of proportional fonts and justified text, a set number of spaces can vary in width. Ensure that your text looks pretty by setting the tabs instead.
• There are several different types of tabs in MS Word. The standard tab aligns text on the left. However, there are tabs for aligning text in the center, on the right, and at the decimal point (to align columns of numbers). To change the tab type, click on the small box at the far left side of the ruler until you see the tab type you like, and then click on the ruler to set the tab.
• Some corollaries to the space vs. tab rule: Don’t insert several tab characters in a row; just reset the tab stop so you only need to hit the tab character once. And don’t tab when what you are really trying to do is change the margins or the indentation. Again, this makes life easier in the event of changes.
• Similarly, use the Table feature of your word processing program to create tables, rather than using tabs or (heaven forbid!) spaces.
• As Nora Favorov reminded me, tables have many other uses besides the standard table with grid lines. For more on this, see the article on the facing page.
• Make use of your word processor’s features for automating numbered or bulleted lists and outlines.

Continued on page 12
Why “teapots,” you ask? It turns out that the Russian series of books equivalent to the “For Dummies” series in the US is called «олх чайник». We thought it far politer to refer to our esteemed readers as teapots, rather than dummies.

The Table menu in MS Word has many uses beyond the obvious. If you are not intimate with this drop-down menu, then you are probably struggling with formatting more than you should be. Spend some time playing with it, and formatting documents will become a whole lot easier. Here are some Table features you may not be aware of:

- To align blocks of text either vertically or horizontally, convert the text to a table without visible gridlines. You can also choose to have some gridlines visible and some not, and change the appearance of the visible gridlines. See the tutorials provided below.
- Text can automatically be converted to tables, and tables to text, using the Convert option.
- Both table entries and ordinary text can be sorted alphabetically, numerically, or by date using the Sort option.
- The Formula option allows calculations within a table, for instance, totaling up the numbers in a column (useful for invoices)—in essence, a primitive version of some Excel functions.

Note that everything in this primer has been tested on MS Word 2003. Depending on your version of Word, things may work a bit differently. Here are a few table basics:

- To create a table, click on Table and select Insert>Table from the pull-down menu. Adjust the number of rows/columns desired, if necessary, and click OK.
- To enter text into a table, click on the desired cell and type.
- To add more rows or columns, click on Table and select Insert>Rows or Insert>Columns. In later versions of Word, you can choose whether the columns are inserted to the left or the right, and whether the rows are inserted above or below your cursor; in older versions, the default is inserting to the right (columns) or below (rows) (I believe). The formatting of the new row or column is the same as that in which your cursor sits. You can also add a new row to the bottom of the table by placing your cursor in the last cell of the last row and hitting Tab.
- The Tab key is used to move from table cell to table cell. To insert a tab within a cell, press CTRL-Tab.
- To select an entire row, click in the margin to the left of the row. To select an entire column, click just above the desired column (your cursor will change to a small, black, down-pointing arrow). To select an individual cell, click just to the left of the cell (your cursor will change to a small, black, right-pointing arrow). Selected rows and columns can be dragged to a different location in the table (an easy way to switch the order of columns or rows).
- Within a table cell or a column, you can change text margins, indentation, justification, and tab stops just as you would for normal text.
- Cells can be combined or divided by selecting the cell(s) and then clicking Merge Cells or Split Cells on the Table menu.

**Tutorial #1:** To create the signature block below, try the following:

**Sincerely,**

Jane Q. Bombast  
Chief Engineer  
Directorate of Dots, Squiggles, Zigzags, and Curliques

John F. Snorkel  
Assistant Grand Pooh-Bah and Special Assistant to the Executive for Decorative Markings  
Department of Pooh-Bahs

1. Click on Table and select Insert>Table from the pull-down menu.
2. Enter the desired number of columns and rows (in this case, 2 and 2, respectively).
3. Put your cursor in each table cell and type in the information shown, with “Sincerely” in the first row and everything else in the second. Put a hard return (“enter”) after Bombast and Engineer in the first column, and after Snorkel and Markings in the second column—but NOT after any other words.
4. To adjust the second-line indentation on Bombast’s directorate name, place your cursor anywhere in the department or title and, in the ruler that appears at the top of the page, drag the top part (the “roof”) of the house-shaped symbol a little ways to the right. Do the same for Snorkel’s title. (Alternatively, from the Format menu, you can select Paragraph>Special>Hanging to indent the “overflow.” In this case, 0.25” would be entered.)
5. To adjust the amount of space appearing under Sincerely, either put your cursor after Sincerely and press Enter as many times as desired; or click on the horizontal line dividing the first row from the second and drag it lower.
6. Highlight the entire table using the mouse, or put the cursor anywhere on the table and from the Table menu select Select>Table.

Continued on page 13
NUTS AND BOLTS  Continued from page 10

- Be consistent. Many formatting elements don’t have hard-and-fast rules. For instance, either one space or two spaces after a period can be acceptable nowadays. Whatever you choose, stick with it throughout your document.

Your client has just sent you a document with elaborate formatting, graphics, and a host of other nightmares. Now what? Here are some helpful techniques for preserving the graphics and formatting (and making you look good!).

- **Typing over.** While this is primitive, it is sometimes the easiest route. If you are working with PowerPoint slides, for instance, or a word processing document in electronic format, you can just replace the source-language text with your target-language text and be left with minimal formatting cleanup to do.

- **Computer-assisted translation (CAT) tools**. TRADOS (which I use), and presumably the other commercially available CAT tools, essentially automate the “typing over” option above.

- **Optical character recognition (OCR) programs**. Many of my source-language documents are either in hard copy or PDF format. So that I could use TRADOS with all of my translations, I invested in an OCR program that can handle Russian. As an added bonus, it permits me to retain all of the original formatting, tables, and graphics.

I had heard that a good Cyrillic OCR program was hard to find, but online research found many raves about ABBYY’s FineReader (www.abbyy.com), which can convert hard copy (via scanner), image files, or PDFs to editable text. (Caveat: I have not used any other Cyrillic-capable OCR programs, so my opinion is one-sided.) FineReader offers the options of removing all of the formatting upon conversion, preserving all of it, or preserving only font and font size. Advantages of FineReader are its ease of use; its excellent character recognition; its ability to convert not only text, but also graphics and tables; to omit any chosen elements on the source page (e.g., page numbers, headers, extraneous markings); and to recognize multiple languages simultaneously. (I usually select Russian, English, and Greek, because the Russian articles I translate often contain English abstracts and Greek symbols.) Disadvantages of FineReader are the time investment one must make to clean up the document, particularly if the original print is faint or very small (true of any OCR program); a bit of awkwardness in the cleanup/spellcheck portion of the program, involving jumping among too many on-screen windows; the fact that, aside from the “retain font” option, one cannot pick and choose which formatting elements to retain and which to ignore; and the fact that the automated page analysis function (identifying segments of text, graphics, and tables) works well only on the simplest documents. However, the manual page analysis, while it may take a few moments, works very well and, as I have mentioned, allows the user to pick and choose which portions of the page are converted and which are ignored. ABBYY also offers a cheaper, PDF-only conversion program, which I have not tested.

For those of you who work in formats other than word processing, such as HTML or PowerPoint, and actually for those of us who work with computers (which is to say, all of us), I’d like to recommend a free e-newsletter. *Tool Kit* is put out by Jost Zetsche, a fellow ATA member and translator who has made numerous ATA conference presentations on getting the most out of your computer. His newsletters are full of computer-related tips and tricks, including information about useful software and freeware, handling tagged document formats, and CAT tools. The most recent issue contained articles on accepting and rejecting changes in MS Word, language selection in PowerPoint, converting files to TRADOS format without TRADOS, and sources for handling attachments. While the newsletter overall is free, one article each issue is made available only to paid subscribers (in the most recent issue, it was an article on handling source-language text embedded in graphics files). Jost has also published *A Translator’s Tool Box for the 21st Century—A Computer Primer for Translators*, which I have not yet obtained but suspect would be useful. I will try to review it in a future column. Both newsletter and book are available from www.internationalwriters.com.

I hope some of this proves useful to you. As always, I welcome your comments, questions, and tricks of the trade at jenguernsey@att.net.

ISO SLOTR Editors for SF*

We are seeking new editors to coordinate *SlavFile* articles in Slavic languages other than Russian. Language editors have a ready-made forum for their views, concerns, and interests, and receive invaluable exposure. They also earn ATA Continuing Education Credits—all this in exchange for a relatively small commitment of time and labor. (We ask editors to supply a minimum of two articles a year that they have written, solicited, or discovered elsewhere.) For further details, see the “SlavFile Lite” column on page 8 or contact Lydia or Nora at the coordinates on the masthead.

* In search of *SlavFile* editors for Slavic Languages other than Russian, of course.
7. From the Format menu, select Borders and Shading>None and click OK.

You now have a table with gridlines that will be grayed out on your screen and invisible in a printed document. If you don’t want to see the gray lines on your screen, from the Table menu, select Hide Gridlines (or, to reinstate them, Show Gridlines). If you need to control the positions of text (or images) in invisible columns, this is the sort of framework you would use.

Tutorial #2. The shape you see below does not look like a table, but it is one. To create this effect—a table with some lines showing and others not—then look again at the Borders and Shading function on the Format menu. In the left-hand column, you can choose from standard formats—no gridlines (“none”), an outline just around the outside of the table (“box”), standard gridlines around every cell (“all”), a thicker box around the outside of the table and thinner lines around the inside (“grid”), or “custom,” which can be used to create anything else. In the central column, you can select the type of line (solid, dotted, double, triple, etc.) as well as its color and width. The Preview pane, in the third column, is where you indicate which lines you want installed or removed and shows you how your selections will look. Just below the Preview pane, you can choose whether your choices will apply just to the cell(s) you have selected or to the entire table. Here is an example.

1. Create a table (see step 1 above) with two columns and three rows.
2. Highlight the entire table and pull down the Borders and Shading option. In the left column, select None to clear out all of the gridlines.
3. Now look at the Preview box on the right. The preview pane is surrounded by little boxes. Click on the one with the vertical line in the middle. Alternatively, simply click anywhere along the vertical center of the preview display. Either way, you should now see a vertical gridline in the center of the preview display. (If you click in the wrong spot and other gridlines appear, just click on them again and they will disappear.) Note that with these changes, the “None” in the left column automatically changes to “Custom.”
4. Click OK to close the dialogue box. At this point, all gridlines except the central vertical line should be grayed out or invisible.
5. To add a line with a different thickness and/or color—in this case a bottom line—select the bottom two cells and again open up the Borders and Shading function.
6. In the central column, select the line color and thickness desired (in our example, 25% gray and 4.5 point).
7. Double-click the little box next to the preview display that shows a bottom line. Alternatively, click on the bottom line in the preview pane. You should now see a thick gray line at the bottom of the preview pane.
8. Click OK to close the dialogue box. You should now have a table that resembles the one below.
From the editor: This is the second installment of our new Baffle Boris feature. To our disappointment, no readers were moved to send in idiomatic translation challenges, so the ones listed here were again generated by the editorial staff. Starting with the next issue, future SLD Administrator Joseph Bayerl, assisted by a Russian colleague, will take up the challenge of translating submitted Russian idioms and idiomatic usages into English. We hope that readers will begin to send submissions to Joseph as well as to Boris. Features such as these cannot be sustained without reader participation. Please send English idioms to be translated into Russian to bsilversteyn@comcast.net; and Russian idioms to be translated into English to b@yerl.net. We will publish the name of the person submitting each challenge unless requested otherwise.

Notes on the meaning, usage, and possible origins of the English idioms follow the translation listing.

* Boris suggests that interested readers consult Multitran.ru for more literal descriptions of the meanings of both the translated idioms and those that remain untranslated.

### CHALLENGE

| 1. When the s*** (or it) hits the fan. | Когда привет / Когда все раскроется (в зависимости от контекста) 
The s*** has hit the fan. | Все раскрылось. Разразился скандал. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2. <strong>Cut to the chase!</strong></td>
<td>Ближе к делу! / Давай ближе к делу! / Короче!!</td>
<td></td>
</tr>
<tr>
<td>3. S*** or get off the pot.</td>
<td>Или делай (либо другой слог, подходящий по контексту), или дай другому.</td>
<td></td>
</tr>
<tr>
<td>(elegantly rephrased as: Defecate or abdicate.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. <strong>If looks could kill</strong></td>
<td>Испепелить взглядом</td>
<td></td>
</tr>
<tr>
<td>5. Don’t sweat the small stuff.</td>
<td>Не заикливайся / Не задерживайся на мелочах.</td>
<td></td>
</tr>
<tr>
<td>6. <strong>Think outside the box.</strong></td>
<td>Думай шире.</td>
<td></td>
</tr>
<tr>
<td>7. If it looks like a duck, walks like a duck, and quacks like a duck, then it is a duck.</td>
<td>Если на клетке слона увидишь надпись «Буйвол», не верь глазам своим. (Козьма Прутков)</td>
<td></td>
</tr>
</tbody>
</table>
| 8. **Take it or leave it.** | Либо так, либо никак. 
Не хочешь – (ну и) не надо. |
| 9. Talk the talk and walk the walk. | Слово не расходится с делом. |
| 10. Push the envelope. | Readers, if you have a translation of any or all of these to suggest, please send it to us. |
| 11. Like it or lump it. | |

### UNMET CHALLENGES

1. **When the s*** hits the fan.** When a situation becomes critical (and/or messy) or when the disastrous consequences of some action become public. Usage origin estimated as 1930. When you appoint an incompetent crony to a critical position, you must be prepared to take the consequence when the s*** hits the fan.

2. **Cut to the chase.** Get to the point. From editing of motion pictures, a suggestion to eliminate less exciting material and move on to the popular chase scene. *Forget all the preliminaries, I don’t have all day. Cut to the chase!*  

3. **S*** or get off the pot.** Either proceed with a task, or give it up so someone else can complete it. From the 1940s, roughly equivalent to the more socially acceptable “Fish or cut bait.” *If that husband of mine doesn’t finish painting the house soon, I’m hiring a professional; he has to s*** or get off the pot.*

4. **If looks could kill.** An indirect way of saying that someone has just given you or someone else a very hostile (“dirty”) look. Exact origin unknown. *Did you see her face when I told her she would have to pay for the damage? If looks could kill!*

5. **Don’t sweat the small stuff.** Frequently followed by *...And it’s all small stuff.* Don’t worry about trivial things. Arrose as a phrase relatively recently with popularity enhanced by a book series by Richard and Kristine Carlson (e.g., *Don’t Sweat the Small Stuff for Women*), the first of which was published in 1997. So you lost a quarter in the soda machine? *You can afford it, come on, don’t sweat the small stuff.*

6. **Think outside the box.** To have innovative, original ideas, not bound by conventional assumptions. Of relatively recent origin. *Solving this particular problem will require someone who can really think outside the box.*

7. **If it looks like a duck, (walks like a duck,) and quacks like a duck, then it is a duck.** Used humorously or sarcastically when there is resistance, reluctance, or indecision about attaching a label to someone or something, when, in the speaker’s opinion, all the essential features of that label are clearly present. Very recent origin. *He may say he is not a liberal, but just look at his voting record. If it looks like a duck....*
SOME MUCH-NEEDED HELP FOR THE SLD WEBSITE

Meet Dina Tchikounova

Imagine our delight when, about a year ago, we were first approached by Dina, a relatively new SLD member, with an offer to help improve and expand our Division website. Our website is certainly an underused asset, and none of us would have the time to single-handedly make it into the valuable resource it could be—not only for our members, but for web-browsers looking for information related to Slavic<>English linguistic and cultural translation. Please heed Dina’s plea for input.

As the new SLD webmaster, I am excited to contribute to the process of turning the existing website into a valuable source of diverse, up-to-date, and immediately accessible information about Slavic languages and translation resources. I would be happy to work with anyone who has a glossary to offer, a translation resource to share, or an idea about a client education feature we can add to the site. In particular, it would be great if we could find a way to use our website to create opportunities for certified ATA members to earn Continuing Education credits. If you have any suggestions for the new website or would like to share information that could be valuable to your fellow SLD members, I would greatly appreciate it if you could e-mail me at dina@broadreach.biz.

More important, I dream of transforming the SLD website into a treasure chest of stories from the lives of our members. I am sure that each one you—and there are over 400 SLD members in the United States and all over Russia and Europe—has a story to tell, a unique friend you made during a translation project, photographs of unique places you visited during your travels to Slavic countries or around the U.S., great movies in Russian or any Slavic language that you loved. Let’s learn more about each other, find common interests, help each other, and become closer.

I think such information will ultimately help us better understand the essence of the Slavic soul and culture and provide better translations to our clients. I would like to be the first to contribute to the collection by posting stories and photographs from my own recent travels to Russia on the new website.

Technologically, I plan to re-design the website, making it more attractive and easier to navigate, and introducing user-friendly tools, such as blogs and forums, to allow us to easily communicate with each other about various issues and resolve translation conundrums by asking each other questions on the website and receiving answers from the SLD pros.

I fell in love with websites and the Internet about five years ago, amazed by their unique capability to connect human beings all around the world, to allow them to instantaneously share information, and to help people break stereotypes and barriers. I took my first HTML course about five years ago. The rest is history. In 2003, I left my corporate job as a Media Director to branch out on my own as an independent website designer and search engine marketing consultant. Today, I offer full website design services and enjoy creating quality websites that are usable, uncluttered, aesthetic, compliant with current web standards, and, most important, prominently visible in search engines.

I have been a translator and interpreter in many exciting translation projects over the last 12 years, both in the former Soviet Union and the United States. I am Russian to the core, but have been living in the U.S. for the last eight years and traveling to my homeland to visit my family and friends and participate in translation projects. I hold a graduate degree in Teaching English from Magnitogorsk State University (the former Magnitogorsk Pedagogical Institute) in Russia, and a graduate degree in Journalism from Quinnipiac University in Hamden, Connecticut.

I love meeting people of all ages from all walks of life and traveling to new lands to learn about people, cultures and traditions.

Contact Dina at dina@broadreach.biz.
The existing SLD website can be viewed at www.americantranslators.org/divisions/SLD/index.htm.

BAFFLE BORIS  Continued from page 14

8. Take it or leave it. Either accept (some offer) unconditionally or reject it outright. Origin 1576. We are having broccoli for dinner, take it or leave it.

9. Talk the talk and walk the walk. Not merely espousing, talking about or giving lip service to some particular philosophy, role, principle, etc., but living by it as well. Very recent origin. He’s no hypocrite; not only does he talk the talk, he walks the walk as well. Newer variant: walk the talk seems to mean “practice what you preach.”

10. Push the envelope. Exceed the limits of what is normally done or even normally considered possible, involving the taking of risks. Popularized by the book The Right Stuff (Wolfe, 1979). It is an aviation metaphor; the envelope referred to is a graphic representation of a plane’s safe performance limits. Sportscaster: This is a very difficult dive. He is really pushing the envelope on this one.

11. Like it or lump it. Essentially a stronger and ruder version of take it or leave it. Whether or not you agree, you will have to tolerate something. Origin: 1880’s. “Lump” may be a euphemism for “stuff.” I don’t care what you say, I am going to marry Fang. You can like it or lump it.
COMMON MISTAKES OF NON-NATIVE SPEAKERS OF RUSSIAN

PART 3

Elena Bogdanovich-Werner

Some of the common mistakes made by non-native speakers of Russian are related to lack of exposure to the cultural-historical environment and social interaction typically occurring in the process of acquisition of Russian as a native language. Human cognition is the product of the cultural-historical environment and can be examined in terms of internalization of social interactions. The native tongue participates in the cognitive development of an individual. In the process of second language acquisition, the individual is not (or is only partially) immersed in this cultural-historical environment and thus fails to internalize the patterns of social interaction occurring within it. Hence, his language use is always somewhat different from that of the native speaker. It is common knowledge that the cultural norms of different languages do not coincide. When an individual starts learning a second language, he does not begin from scratch but tries to adapt his existing communication skills formed in one cultural environment to the requirements of another cultural environment— that of the language being acquired.

This happens frequently when a non-native speaker of Russian tries to express his/her emotions and feelings in Russian. Sometimes such speakers sound cold, distant, inappropriately withdrawn and indifferent to Russian ears, while, sometimes, on the contrary, they readily express their love and say without any hesitation “Я тебя люблю.”

Russians are less inclined to openly express positive emotions. For example, the idea of ending a conversation with family or close friends by saying “I love you!” or “Love you!” seems strange to them. Of course this does not mean that Russians do not love their family or friends, they just never use this phrase in this particular context. They express love by showing involvement and concern for another person using verbs such as волноваться, переживать, скучать. It is very important in Russian culture to show that you are concerned about the well-being of someone you love. Thus, the following phrases in certain situations might indirectly express love:

1. Наконец-то ты позвонила, а то я уже начала волноваться, не случилось ли чего. Как твои дела? (at the beginning of a conversation)
2. Смотрите, осторожно там на работе. А то я переживаю. (at the end of a conversation)
3. Приезжай скорей домой после работы, я уже соскучилась. (at the end of a conversation)
4. Ты расстроен? Меня очень тревожит твоё настроение.

For Americans, use of phrases like these might suggest that the speaker is looking for something negative, something to worry about, but actually this is an indirect way of expressing interest/love/involvement toward another person. A Russian might say about someone who shows no interest in him/her: “Ты хоть умри, а ей/ему всё равно. Он/она даже и минуты волноваться не будет.” Showing compassion and care seem to be more important than direct declarations of love.

Linguistic research suggests that there may be both cultural similarity and diversity in emotions, and studies demonstrate that Russian and English differ in the ways in which emotions are conceptualized and expressed in discourse. It has been suggested that the process of second-language acquisition should include instruction in patterns of socialization, which may help to restructure an individual’s emotional categories and behavioral patterns when he/she uses a non-native language.

Ways of expressing emotions in a language are determined by cultural norms, the features of the particular language, and the individual’s own personality. Numerous examples demonstrate that English speakers are more open to expressing their feelings and emotions, especially positive ones; however, the emotions they express are usually perceived by Russian as superficial and shallow. Such descriptions of positive emotions as наслаждение, экстаз, счастье, любовь, восторг, восхищение, очарование, ликование etc. are viewed by Russians as very deep and elevated and quite inappropriate for use in everyday life situations. Here are some examples:

E: We will be happy to assist you. R: Мы будем рады помочь вам, ой Мы с удовольствием поможем вам. Not: Мы будем счастливы помочь вам.
E: When they managed to do it, they were ecstatic. R: Когда им это удалось, они были вне себя от радости. Not: они были в экстазе.
E: Have fun, guys! R: Повеселитесь от души, ребята! Not: Получите удовольствие, ребята!
E: I was not exactly happy to see him. R: Я не совсем обрадовался, когда встретился с ним. Not: Я не совсем был счастлив...
E: I am loving every minute of this show. R: Мне нравится это шоу с первой его минуты. Not: люблю каждую минуту этого шоу.
E: We are delighted to see you again. R: Мы очень рады/ довольны, что смогли снова увидеться с вами. Not: Мы восторгены, что смогли снова увидеться с вами.
E: He was truly fascinated by the boy’s ability to type. R: Он был по-настоящему удивлён способностью мальчика печатать. Not: Он был по-настоящему очарован способностью мальчика печатать.
E: I hate to tell you about it. R: Мне не доставляет радости говорить тебе об этом/Я не хочу говорить тебе об этом/ Мне неловко говорить тебе об этом. Not: Я ненавижу говорить тебе об этом.
E: I hope there are no hard feelings! R: Надеюсь ты не в обиде на меня! Not: Надеюсь у тебя нет тяжёлых чувств ко мне.

E: Our neighbors with a crazy dog are moving away? That really makes my day! R: Наш соседи, у которых бешеная собака, переезжают? Вот радость-то какая!/Нау и осчастливили! Not: Это действительно сделало мой день радостным.

E: My heart goes out to all the people who lost loved ones in the tsunami. R: Мое сердце идёт к тем, кто потерял близких в результате тайфуна. Not: Мое сердце идёт к тем, кто потерял близких в результате тайфуна.

E: Joe is so stressed out about his job that he cannot sleep at night. R: Джо так переживает из-за своей работы, что не может спать ночью. Not: Джо в таком стрессе по поводу...

E: It's a shame I did not know you were in town. R: Да смешно, что я не знал, что ты здесь. Not: Меня стыдно/Мне совесть...

Conceptually, emotions in Russian can be represented as impressions, states, and uncontrolled feelings in the form of nouns.

A. Impressions are generated by specific aspects of the external world and they are seen as being brought or delivered to the individual from his external environment, hence the following combinations: принести/доставить (горе, огорчение, радость, удовольствие).

B. Spontaneous feelings are usually conceptualized as external, very often hostile, forces that take over an individual, hence the use of nouns expressing uncontrolled feelings with the verbs: охватывать/охватить, овладевать/овладеть (стыд, тоска, грусть, тревога, беспокойство, страдания). Им овладел страх. Его охватила какая-то необычайная тревога.

C. Emotional states are viewed as reactions to some event in the external world. They may be 1) short-term states that people fall into and which are overtly manifested (впадать/впасть; приходить/прийти; приводить/привести; поверьть/повернать в разражение, в ярость, в бешенство, в ужас, в восторг, в замешательство, в гнев); 2) deeper states that do not necessarily imply overt manifestations, which people are usually portrayed as plunging into (погрузиться/погрузиться в печаль, депрессию, скорбь).

These combinatorial patterns are very important in avoiding mistakes in describing emotions in Russian. Here are some examples:

A. Impressions
E: He was overwhelmed with joy. R: Радость переполняла его. Not: Его охватила радость.
E: Rebecca was extremely delighted to see him humiliated. R: Ребекка была очень рада видеть его униженным. (A) Not: Ребекка приходила в наслаждение, когда она видела его униженным.

B. Spontaneous feelings
E: There was a general panic. R: Всех охватила паника. Not: Все впали в панику.
E: Terror invaded our minds. R: Мы впали в ужас. Нас погребло в ужас.

C-1. Emotional states (short-term)
E: The scene made him furious. R: Происходящее повергло его в гнев. Not: Его охватил гнев при виде происходящего.
E: News of defeat filled them all with gloom. R: Новость о поражении привела их всех в уныние. Not: ... приняла им униение.

C-2. Emotional states (deeper states)
E: He was going into one of his declines. R: Он снова погрузился в депрессию. Not: Он приходил в упадок.

In the next article in this series we will continue to consider more mistakes that are made by non-native speakers of Russian due to their lack of knowledge of cultural behavioral patterns and compare the lexical patterns that are favored by Russian and English in the expression of emotions.

Elena can be reached at elena@hillsdalecorp.com.

NEWCOMERS TO THE CONFERENCE AND/OR SLD SEE ARTICLE ON PAGE 2.
BEGINNER’S LUCK  Continued from page 4

6. Spread the word. Or at least, state your intention of doing so. If your client is a US business entity, let them know that you will be inquiring with the local Better Business Bureau and Chamber of Commerce (“to determine if there is a pattern of non-payment,” you might tell them). Don’t expect the BBB or CoC to be your collection agency, though, or even to take any significant action at all. At best, after months of not hearing back from the client or having received a blatantly inadequate reply to repeated inquiries, the BBB may post an “unsatisfactory” rating. Don’t forget that neither BBB nor CoC membership is earned; it’s purchased.

This method may also, of course, be applied to non-US entities. You just need to locate the appropriate agencies in the client’s country. And if you already have that information, why not pass it on to me? I would love to publish a reasonably comprehensive list in this column.

7. Engage your colleagues, if you are comfortable doing so. A report of payment problems on a payment practices board such as Translator Client Review (www.tcrlist.com) often elicits offers of direct assistance from translators or interpreters living close to the client’s place of business, even outside the US. I am not necessarily recommending this tactic; I am just letting you know that such offers may come, and you will need to balance the advantages against the disadvantages most carefully.

8. Leverage your ATA membership. We all know that the ATA Ethics Committee is also not a collection agency and will not involve itself in commercial disputes between members, including disputes regarding payment. (See Muriel Jérôme-O’Keeffe’s “Opinion” article in—the April Chronicle, and the formal statement “ATA Commercial Disputes Between Members” in the June Chronicle, which is also at the “More Information for ATA Members” section of the “Members Only” area of the ATA website. And if you want a clear statement of what the Ethics Committee does do, see “Administrative Procedures for Professional Ethics Proceedings” in the same section). Still, I don’t see how it could hurt to remind a corporate or individual ATA member that collegiality should count for something and that we all have the same basic ends in view (advancement for our profession and fair treatment for ourselves).

9. Reinforce your paper trail. If your client is in the US, you might want to send a final demand “before taking more serious action” via the good old-fashioned US mail with delivery confirmation, or even by overnight delivery, if the sum warrants it. Give the client a specific date by which to respond appropriately, and then stick to it.

I can’t believe I stopped at 9. These are not all the methods that I have heard of, but I hesitate to detail some of the others, because I am not certain of their legal validity. So let’s move on...

If your money still is not forthcoming, enough time will have elapsed by then to leave you in no doubt that you are going to have to fight harder. All of the above methods are free, or almost free. The next level requires a more serious commitment of time and money on your part, and an important question you need to ask yourself now is: How collectible is this debt—really?

That is a key point made repeatedly in Jim Heath’s How to Collect Business Debts (www.viacorp.com/DebtBook.html). This excellent little publication, now accessible free of charge online, was written in 1990 and is based on the law in Victoria, Australia, but even so is studded with gems of common sense. If you’re not up to reading the whole thing, jump to the section on debt negotiation, from the link under item 8 in “Before We Start...” There are, of course, numerous books that you can buy on collecting debts (and, disturbingly, on avoiding paying debts), but before shelling out your hard-earned cash, even at the money-saving www.fetchbook.info, you need to consider how relevant the information will be to our line of work, and how keen you are to hear again what you’ve heard so many times before.

***

There is a lot more to talk about, but this column is already quite long enough, so I shall take up the subject again in the next issue of SlavFile. Meanwhile, I would really like your feedback on what you have read so far. Have I omitted something that worked like a charm for you? Am I too kind to delinquent clients and generally too much of a wuss for your taste? Tell me what’s on your mind, at bliss@wmonline.com.

EXPOSE YOURSELF! SUBMIT TO THE SLAVFILE!

We welcome unsolicited articles of all kinds, glossaries, profiles, reviews, letters, artwork, jokes, and/or ideas for columns or features. Contact Lydia or Nora at coordinates on the masthead.
ATA 46th Annual Conference  Continued from page 1

SL-3 Idioms: A Major Source of Translators’ Mistakes
Anastasia L. Koralova
See Carley Hydusik’s review of this speaker’s presentation in Toronto, “The Role of Culture in Translation” (SlavFile, Spring 2005) or Dr. Koralova’s fascinating paper in the Toronto conference proceedings for a preview of this presentation, which promises to combine analysis of the complex semantics of idioms with practical tips on proper usage and translation. Dr. Koralova has taught translation at Moscow Linguistic University and is currently teaching Russian at the University of North Carolina at Charlotte.

SL-4 Of Camels, Virgins, and Perrier Cognacs
Konstantin I. Lakshin
Konstantin Lakshin’s previous presentations in Phoenix and Toronto (reviewed in the Winter 2004 and Spring 2005 issues of SlavFile) were highlights of those two conferences for many of us in the SLD. This presenter has a talent for discerning translation error patterns, which he illustrates with well-chosen examples from real documents. This year, he will look at a few very serious translation problems that are all too common in business, legal, and technical translations into Russian and examine strategies for avoiding them.

SL-5 Annual Susana Greiss Lecture: Medical Translators and Medical Dictionaries
Svetolik P. Djordjevic
The Greiss lecture was established in honor of the SLD’s founder, Susana Greiss, who, for the only the second time since 1980, will not be able to attend the conference due to knee surgery. Paul Djordjevic is a translator for the Social Security Administration working in French and all the Slavic Languages, among others. His frustration with the lack of adequate resources for translators turned him into a sort of accidental lexicographer. The second edition of his French>English Dictionary of Medicine came out in 2004, and he will soon publish an English>Serbian medical dictionary and a Croatian and Serbian>English medical dictionary, each containing over 45,000 entries. To learn more about our Greiss lecturer, see our interview with him on page 3.

SL-6 Between Norms and Style: Translating Punctuation (Russian>English)
Brian James Baer and Tatyana Y. Bystrova-McIntyre
Although I cannot claim any inside knowledge about this talk, the title is intriguing. Where do norms end and style begin? The speakers (who are both from Kent State University’s translation program, where Brian James Baer is an associate professor of Russian translation and Tatyana Bystrova-McIntyre recently received her MA) promise to present research data on “key differences both in the type and in the frequency of punctuation used in English and Russian.”

SL-7 Annual Meeting of the Slavic Languages Division
Alex Lane
At this session, Alex and yours truly will pass our batons to our worthy successors, Joseph Bayerl and Elena Bogdanovich-Werner, the division’s new officers. Come hear about the new administrators’ plans and join discussions on what we want out of our division.

SL-8 This is a Fact: Mistakes of Russians in English
Lynn Visson
This session makes a nice complement to last year’s presentation and the recent articles by Elena Bogdanovich-Werner on mistakes English speakers make in Russian. Lynn Visson, who proved herself to be a highly entertaining speaker as our Greiss lecturer in 2000, will explore how language patterns rooted in cultural differences can lead to misunderstandings between native English speakers and native Russian speakers of English. She has been a long-time staff interpreter at the UN for Russian and French into English and is the author of numerous books and articles. Of greatest relevance to this presentation is her recent book «Русские проблемы в английской речи: слова и фразы в контексте двуих культур».

SL-9 Mitigation of Cross-Cultural Differences in English>Ukrainian Translation of Financial Terms
Tatyana Sayenko
Again, I cannot claim any inside knowledge about the speaker or topic, but Tatyana Sayenko brings the perspectives of both a scholar in the theory and practice of translation and a working interpreter to her subject. She is an associate professor in the Department of Theory and Practice of Translation of English at Taras Shevchenko National University in Kiev and has interpreted for international financial institutions in Ukraine. Her list of publications includes the English-Ukrainian Illustrative Glossary of American Financial Terms.

SL-10 Translating Humorous Russian Poems for Children: Word Games and Pet Names, Pit Falls, Prat Falls, and Tough Calls
Lydia Razran Stone
This is our only purely literary session this year. Take a look at the end of Lydia Stone’s “SlavFile Lite” column in this issue to get in the mood to have some fun with nonsense poetry. Lydia has been “fooling around” (so states her abstract) with translation of Russian children’s poetry for decades. Topics to be discussed include: cultural differences in children’s poetry; Aesopian language and the use of children’s verse to convey adult messages; the sound-sense relationship when the sense is nonsense; the particular problems presented by diminutives and grammatical rhymes; and the difficulty of getting translated children’s poems published in the U.S.

SL-11 The Shtirlitz Context
Alex Lane
Anyone who knows our outgoing division administrator knows that the guy can tell a joke (in at least two languages). This session will explore “the curious phenomenon of the ‘Shtirlitz joke.’” Native Russian speakers will not want to miss this visit to the jokes of their childhood, and native English speakers should not miss this opportunity to expand their cultural literacy.

SL-12 Slavic Languages Division Post-Conference Wrap-Up
Alex Lane
Here’s where we critique the just-completed conference, make plans for next year, and discuss any unfinished business.
Come Join us at *The Mirage*

SLD Annual Banquet and Sing-along

8 PM, Friday, November 11, Seattle, Washington

Thanks to the hard work of local members Larissa Kulinich and Emma Garkavi, arrangements have been finalized for the Annual SLD Banquet and Sing-along at the Armenian restaurant *Mirage*. The cost will be $45/person, which includes an incredible feast, musical entertainment, a cozy atmosphere, tax and tip – everything except transportation and alcoholic beverages. Transportation will be arranged on-site. (We need to have an idea of our numbers before we know whether or not a bus will be economical.)

We will gather in the lobby at 7:30 for a prompt 7:40 departure immediately following the panel on Interpreting at Major Historical Events, scheduled for 6–7:30. If this session runs over and you want to stay to the end, you can take a taxi to the restaurant, located at 15920 8th Street NE, Bellevue (425-641-5778). Bring with you:
1. Two rhyming words in English, Russian or Ukrainian (for SLD Burime master Vadim Khazin);
2. Your Dover Russian Songbook (if you have one);
3. An appetite;
4. Your dancing shoes;
5. Your thinking cap for a mini-game show with our charming and talented emcee, Larissa Kulinich (there will even be prizes!).

To reserve your spot, please send a check for $45 made out to Nora Favorov to 100 Village Lane, Chapel Hill, NC 27514. You can also send a PayPal payment to norafavorov@bellsouth.net. Nora can also answer any questions about the event.